VariOSTips

Do you want to have the VariOS play a much greater role in the music production process? Do you want to use the VariOS
with your sequencer, such as SONAR or Logic? If so, you need to read these pages, which are packed with techniques for
taking advantage of the VariOS in actual music production situations.

Since the explanations use actual screen shots, potentially complicated setting screens are made easy!
Frequently encountered problems are also described, along with the appropriate counter-measures.

And now, onward to revolutionize your music production with VariOS!

V-Producer

Here wel'll discuss techniques for using the V-Producer software included with VariOS.

Synchronizing V-Producer with the five most popular sequencers NEW!!

Well explain synchronization techniques with SONAR, L ogic, ProTools, Cubase, and
Digital Performer. At al steps, we'll provide easy-to-understand screen shots.

MIDI drivers

Here we discuss MIDI driver settings for using the VariOS with your computer.
MacOS 9: Check your OM S settings NEW!!

Full explanations of using the VariOS with MIDI interfaces such asthe MOTU MIDI express
or AMTS.

MacOS 9: Check your FreeM|DI settings NEW!!

A must-see for Digital Performer users! Complete discussion of settings for FreeM I DI!

Trial applications (VariOS-8/VariOS303)

This section discusses techniques for using the VariOS'strial applications; VariOS-8 and VariOS 303.

MacOS 9: Caution when switching the VariOS between VariOS-8/VariOS 303/VariPhrase modes
NEW!!




When you turn the power of the VariOS on/off to switch the VariOS program, MIDI
communication between the VariOS and your application may fail. If this occurs, the problem
usually lieswith OMS.

MIDI settings when using VariOS-8/303 with your sequencer NEW!!

Settings when using VariOS-8/303 with a sequencer such as SONAR or Logic. Prevent
doubled notes!

Synchronizing VariOS303 to the tempo of your sequencer (coming soon)

A thorough discussion of synchronizing the VariOS 303 step sequencer to your sequencer
software such as SONAR or Logic!

Synchronizing VariOS-8 to the tempo of your sequencer (coming soon)

Everything you need to know about synchronizing the VariOS-8 arpeggiator to your sequencer
software!

Recording VariOS-8/303 controller knob movementsin your sequencer (coming soon)

This provides afull explanation of how to record VariOS-8/303 controller knob movementsin
your sequencer (e.g., SONAR or Logic).

Controlling VariOS-8/303 from your MIDI controller (coming soon)

This provides tips for controlling VariOS-8/303 from your MIDI controller (we'll use the
Edirol PCR series as an example).
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Synchronizing V-Producer with the five most popular synthesizers

V-Producer can use MIDI Clock or MTC (MIDI Time Code) to synchronize with a variety of other software.

If you want to synchronize V-Producer to aMIDI sequencer (SONAR,
ProTools, Logic, Cubase, Digital, Performer, etc.) installed in the same
computer, using MIDI Clock for synchronization is the simplest, so it isthe
recommended method. When synchronizing with MIDI Clock, V-Producer Sc

1N
will play according to the tempo of the master sequencer program.

If you want to synchronize with aMIDI sequencer that is running on the
same computer, select the MIDI device as“Roland VariOS Sync” (the

dedicated synchronization port for the VariOS).

Here we will describe settings for some typical MIDI sequencers.

. V-Producer synchronization settings (slave)

From "Roland VariOS Sync," make settings so that MIDI Clock will be received.

. Synchronization settingsfor your sequencer software (M aster)

Set "Roland VariOS Sync" so that MIDI Clock will be transmitted.
o SONAR
o Logic Audio
o ProTools
o Cubase VST
o Digital Performer
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V-Producer synchronization settings

Make the following settings so that V-Producer will operate (as a slave) according to the MIDI clock of your MIDI sequencer.

* |f you are using Mac OS 9.x, you should first check the OM S settings as described in "OM S settings.”

1. Choose Option - MIDI Sync.

2. Inthe Sync Maode dialog box, select "Roland VariOS Sync” for "IN" under Sync IN.

Sync Mode Dialog
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3. Set the Type of sync field to “MIDI Clock.”



Sync Mode Dialog
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* Y ou can aso switch the Sync mode by using the Sync buttons in the locator.
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4. Click [OK]. V-Producer will now synchronize to the playback of the master program.

* |f V-Producer's loop mode is on, V-Producer will give priority to its own looping rather than to the playback location of the master

MIDI sequencer.

* |f Sync mode is [MIDI], you cannot use the controls of the locator section to start playback or control the tempo. If you want to

control playback from the locator, set the Sync mode to [INT].

Most sequencers do not re-transmit playback position data at the beginning of aloop. Thus, if your master sequencer is set to loop the
playback, V-Producer will ignore the looping of the sequencer, and will simply continue playing asit had been. To avoid this

problem, set V-Producer to the same loop region as the loop region in your master sequencer, and turn on loop mode.

Next, make synchronization settings for your M1DI sequencer.




OM S settings for using the VariOSwith Mac OS 9.x

If you will be using the VariOS on Mac OS 9.x with aMIDI interface such as AMT8 or MIDI EXPRESS, make OMS settings as
follows.

* Most problems that occur when using the VariOS on Mac OS 9.x are due to incorrect OM S settings. Please re-create your
OMSS settings once again.

The VariOS does not work correctly

Your MIDI interface (e.g., AMT8 or MIDI EXPRESS) has stopped working

Y our software such as Logic or Pro Tools has stop working correctly

Y ou can't use V-Producer simultaneously with software such as Logic or Pro Tools

1. Install OMS. (If you have already installed OMS, proceed to step 2.)

On the VariOS CD-ROM, navigate to the English - (for OS 9 )- Driver - OMS2.3.8 folder, and double-click
"Install OMS 2.3.8." to perform the installation.

&

Inztall OM3 2.3.5

* In thisstep you should install the OM Sdriver for the MIDI interface you areusing (e.g., AMT8 or
MIDI EXPRESS). For details, refer to the owner's manual of your MIDI interface.

2. Install the VariOS OM S driver.

On the VariOS CD-ROM, navigate to the English - (for OS 9 )- Driver -VariOS OMS Driver-E folder, and
double-click "VariOS OMS Driver-E Installer" to perform the installation.

Yarids OrM3 Driver-E Installer
3. Connect all your MIDI equipment (including the VariOS) to your Mac, and turn on the power.

4. Double-click OMS Setup.

Within the location (hard disk) to which you installed OMS, go to the Opcode - OM S Applications folder, and
double-click OMS Setup.

@

OrS Setup

5. Select the File menu and click “New Studio Setup.”



6. In the “ Create a New Studio Setup” dialog box, click [OK].

Create a Mew Studio Setup

& studio setup document isa list of wour MIDI
devices and cables between them,

You use it totell applications what™s inyour
studia,

Click Ok to have OM3S autamatical ly locate wour
MIDI devices and build a nesw studio setup
document.

7. Inthe OMS Driver Search dialog box, click [Search] without checking the check box.

ars Driver Search

OMS will now search far FIDI cards, interfaces, and software
sunthesizers. These devices are controlled by drivers.

Click to check the external ports to search for MIDI interfaces:

|:|. Printer

i | b |

—
Cancel |
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8. Make sure that the OM S Driver Setup dialog box correctly indicates VariOS USB |F.

Only the MIDI devices connected directly to the Macintosh are displayed here. Verify that your device(s) are
displayed correctly, and click [OK].
* As an example here, we will show how to connect the "MIDI Express XT" MIDI interface.



OMS Driver Setup

03 has detected the fallowing dewices installed on wour computer. This

lizt does not include external MIDI devices like sound modules, keyboards,
and drum machines.
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Click “0K™ if this list is correct. Click “Troubleshoot™ if this list is

incorrect or incomplete. Click “Customize™ to add drivers manually.
Click “Cancel™ to abort OMS setup.

Cancel ] [ Customize ] [Trnuhleshnnt] | Ok, II

9. The OMS MIDI Device Setup window will appear

Scroll the screen, check all items, and click [OK].

OrMS MIDI Device Setup
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ick “0k™ when this list is correct. Click “Troubleshoot™ if this list is
incomplete. Click “Customize™ to edit details of wour setup, Click
“Cancel ™ toabort OMS setup,
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10. In the screen for saving the studio setup, click [Save] to save the setup.




11. Assign thefollowing n

ames to each port of the VariOS.

Port name displayed Assign the following port name

Function

Portl Roland VariOS MIDI Port for the VariOS sound module section
Port2 Roland VariOS External MIDI  |Port for the VariOS rear panel MIDI connector
DX7 Il Roland VariOS Sync Macintosh internal synchronization (sync) port
O # My Studio Setup B8
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12. [Important] Enable" Use MIDI in the background.”




From the Edit menu, choose OMS MIDI Setup. In the dialog box that appears, check [Use MIDI in the
background], and click [OK].

* Unless you make these settings, you will not be able to use V-Producer simultaneously with software
such asLogic and Pro Tools.
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T by MIDI interfaces until all OMS applications
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13. From the File menu, choose Make Current.

If you are unable to select Make Current, it has already been applied, and you may continue to the next step.
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O y Studio Setup === HH
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Opend 30
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Close 38w
Save S
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14. From the File menu choose Quit to exit OMS Setup.

A dialog box will suggest that you save, so click [Save]. Basic settings for OM S are now compl eted.






SONAR synchronization settings

First make synchronization settingsfor V-Producer.

* The explanation in this document uses SONAR 2.0. Please be aware that some screens and menu names may differ in other
versions.

* Depending on the MIDI interface you are using, you may be unable to hear the sound from the VariOS if you first start
SONAR 2.0 and then start V-Producer. If this occurs, start V-Producer first, and then start SONAR 2.0.

1. Choose Options - MIDI Devices.

2. Inthe MIDI Device dialog box, choose “Roland VariOS Sync” in the Output Devices field.

At thistime, make a note of the port number for Roland VariOS Sync.

Thetop MIDI devicethat is selected in the list of output devicesis assigned to MIDI output port 1, and the
next MIDI deviceis assigned to MIDI output port 2, and so on.

MIDI Devices Ed
Click on devices to select or deselect MIDI inputs and outputs. oK
[npLits: Cutpuits:
Raoland SfariCs MHIDI & Raoland YWariCo MIDE
Poland WariQS External MID] _I et s e e L e Cancel
Foland VariZs Sync :Foland WariUs Sync
e ;
Microzoft G35 Wavetable 3W Syith Help

v ‘warn about no MIDI devices. Move Selected Devices to Top

3. Click [OK].

4. Choose Options - Project.

5. In the Project Options dialog box, click the [MIDI Out] tab.



Set the “ Send MIDI Sync” fields as shown below.

Clack, ] Metrnnnme] MIDI Input  MIDT Out ] ak.

| SendMIDISyne Cancel

t v Transmit MIDI Start/Continue/Stop/Clack: ’ Hel
&lp

I Use Start, Never Continue

( v Transmit MIDI Song Position Pointer [SPP) ) Setto 30 40 J

Locate Delay for SPP Recipient: ‘m

The "Roland VariOS Sync"
MIDI port number you noted
in step 2 in this example,
it is the third from the top,
s0 you would enter "3."

MIDI Machine Control [MMC)
I Transmit MMC

Timecaode Master's Unit [0

Other Options

W Zero Controllers 'When Play Stops

v Patch/Controller Searchback Before Plap Starts

* Set the “Locate Delay for SPP Recipient” in the range of 30D40.
* Set the MIDI output port to the Roland VariOS Sync MIDI port number you noted in step 2.

6. Click [OK].



L ogic synchronization settings

First make synchronization settingsfor V-Producer.

* |f you are using Mac OS 9.x, you should first check the OM S settings as described in "OMS settings.”

* The explanation in this document is for Logic Audio 6.0. Please be aware that differences in the software version may
mean that the windows or menu items may be slightly different.

* [Important] If you are using Mac OS 9.x, check "Use OMSiif available" in [Options] - [Preferences] - [MIDI Interface
Communication...].

1. Choose [Optiong] - [Song Settings] - [Synchronization Settings...].

* Onthe Mac OS X version, thiswill be [File] - [Song Settings| - [ Synchronization Settings...].

Options
Preferences 4
Song Settings 4

Siynchronisation Settings...
2. Click the [MIDlI]tab.

Check the “Transmit MIDI Clock” option, and choose “Roland VariOS Sync” as the output destination.
Uncheck “Allow Song Position Pointer while playing.”



Uncheck
if this is checked, V-Producer

will stop when Loop is used.

3. Click the [General] tab, and uncheck “Auto enable external Sync.”

* [NOTE] MIDI Clock loop happened inside L ogic may freeze the programsif you do not makethis
setting.
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4. Close the dialog box.

If you areusing Mac OS 9.x, and hang-ups (MIDI Clock loops) still occur even though you have made
the above setting, try making the following setting.

1. Choose [Options] - [Preferences] - [OMS Preferences] - [Input Mapping...].

(EIRGT BN Windows |
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2. Uncheck the “Connect all Real OMS Input Instruments with Logic” check box.

Then choose "Input connection setting” only for the MIDI port used for input to Logic (e.g.,
the port connected to the MIDI keyboard you use for input). However, do not select "Roland
VariOS Sync" for "Input connection setting.”



= Preferences

OHS Input Connections
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If this is checked, MIDI Clock
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Logic, which may cause a
hang-up to occur.
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3. Closethe diaog box.




ProT ools synchronization settings

First make synchronization settingsfor V-Producer.

* |f you are using Mac OS 9.x, you should first check the OM S settings as described in "OMS settings.”

* The explanation in this document uses Pro Tools LE 5.0.1 for MacOS. Please be aware that some screens and menu
names may differ in other versions.

* INOTE]If you arerunning ProTools and V-Producer on the same computer and synchronizing them, you must
first start up ProTools and then V-Producer. If an application that uses OM S (such asV-Producer) is already

running, ProT ools may fail to start up.

1. Choose MIDI - MIDI Beat clock.

2. Check the “Enable MIDI Beat Clock” and “Roland VariOS Sync” check boxes.

=— MID| Beat Clock

HMIDI Beat Clock

] Enatle MIDI Beat Clock

|:| FastlLane
™MD T
REoland YarDSSync

el
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3. Click [OK].



Cubase VST synchronization settings

First make synchronization settingsfor V-Producer.

* |f you are using Mac OS 9.x, you should first check the OM S settings as described in "OMS settings.”

* The explanation in this document uses Cubase VST 5.0 for MacOS. Please be aware that some screens and menu names

may differ in other versions.

* [Important] If you are using Mac OS 9.x, make settings so that Cubase will use OMS.

Go to Options - MIDI Setup - System, and change the OM S Compatibility setting from “No OMS’ to “IN & OUT.” Then

re-start Cubase.

1. Choose Options - Synchronization.

2. Inthe Sync Out area of the Synchronization dialog box, select “Roland VariOS Sync” for the MIDI Clock field, and turn

it “On” as shown below.
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3. Click [OK].







Digital Performer synchronization settings

* The explanation in this document uses Digital Performer 3.0. Please be aware that some screens and menu names may differ in
other versions.

FreeMIDI settings

1. First, make Free MIDI settings.

V-Producer synchronization settings

2. Select FreeM|DI asthe MIDI driver that V-Producer will use.

From V-Producer' [Option] menu, choose “MIDI Settings...”
In the FreeMIDI MIDI Settings dialog box, set MIDI Driver to “FreeMIDI Driver.”
Option i

MIDI Settings...

Feload %arids

[

FreeMiDl MIDI Settings

........... vﬂrius
--------- MIDI Device
MIDI IN Port MIDI OUT Port MIDI Clock
|Roland WarioS Mi.. 4]  [Roland Varios Mi.. # ] 4

MIDI M Port (Keyboard)
| Roland Varios Ex.. | $ |

----------- MIDI Driver
3 0MS Driver

® FreeMID| Driver

Cancel ] || Ok “




Click [OK] to close the FreeMIDI MIDI Settings dialog box.

3. Next, make settings so that V-Producer will synchronize to the MIDI clock data transmitted from Digital Performer.

From V-Producer' [Option] menu, choose “MIDI Sync...”
In the Sync Mode dialog box, set the Sync IN “IN” field to “Roland VariOS Sync” as shown below.
Inthe Sync IN “Type of sync” field, select “MIDI Clock.”

Option QEEARERY
ML '

MIDI Sync...

o e L el B e o

Sync Mode Dialog

----------- Sync IN SHMPTE Offsets
M song Start Time
T ¢ Hour Min Sec Frame
ype of sync
Roland VariOS Sync | Reset I
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|m!
----------- Sync OUT
----------- SHPTE Frame Rate
OUT [ OFF s
(124 Tps () 30 dfps
@ OFF ¥ _p i ;
)23 fps w30 fps
2 MIDI Clock _
. ; () 2997 dfps
LMD Time Code

[ Cancel ] | Ok II

Click [OK] to close the Sync Mode dialog box.

4. From V-Producer' [Option] menu, choose “MIDI Settings...”
In the FreeMIDI MIDI Settings dialog box, uncheck the “MIDI Clock” box.

* [INOTE] Step 4 isaspecial setting used when you want to synchronize V-Producer and Digital Performer. If you
fail to uncheck this box, V-Producer will play at double speed when synchronized. If you want to play V-Producer

in Internal Mode, check this box once again.
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----------- HIDI Driver
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Click [OK] to close the FreeMIDI MIDI Settings dialog box.

Digital Performer settings

* The explanation in this document uses Digital Performer 3.0. Please be aware that some screens and menu names may differ in
other versions.

5. From Digital Performer' [Basics] menu, choose “ Transmit Sync...”

In the Transmit dialog box, set the “ Transmit beat clocks via port(s)” field to “VariOS Port.”



Change Audio Wind
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«MIDT Patch Thru...
&udio Patch Thru
Set View Filter..
Set Input Filter..
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Edit FreeMIDl Configuration...
Control Surface Setup...

Click [OK] to close the Transmit dialog box.
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Settingsfor using the VariOSwith FreeM | DI

Y ou can use the VariOS with Mark of the Unicorn Corporation's FreeMIDI (*1). In order to useit, you will need to
separately obtain FreeMIDI Version 1.35 or later.

*1: FreeMIDI (Developer: Mark of the Unicorn, Inc.)
FreeMIDI is MIDI driver software that passes data between the computer and MIDI sound modules.

Installing the VariOSdriver for FreeM 1Dl

* The VariOS driver included on the disc is provided as an additional module that allows the VariOS to be used with
FreeMIDI. In order to useit, FreeMIDI must already be installed on the startup hard disk.

1. Install the VariOS driver for FreeMIDI.

In the VariOS CD-ROM, open the folder English - (for OS 9 )- Driver - VariOS FreeMIDI Driver-E, and
double-click the"FM Driver-E Installer" icon to install the software.

Yarils FM Driver-E Installer

FreeM|DI settings

1. Use aUSB cable to connect the VariOS and your computer.

2. Turn on the power of the VariOS and all MIDI eguipment connected to your Mac.

3. Open the "FreeMIDI Applications' folder, and double-click the "FreeMIDI Setup" icon.

m

FreeMID| Setup 1.45

4. Select "FreeM|DI Preferences' from the File menu.

* Thefirst time FreeMIDI is started up, a"Welcome to FreeMIDI!" dialog box will appear. Click
[Continue].



5. Inthe "FreeMIDI Preferences’ dialog box, check "VariOS Port" which islocated below VariOS Driver in MIDI
Configuration, and click [OK]. If you have connected M1DI equipment other than the VariOS, check it aswell.

* |f the dialog box does not show "VariOS Driver," check whether the VariOS is connected correctly, and
start up FreeMIDI Setup once again.

FreeMID| Preferences

Software Compatibility MIDI Configuration
i) FreeMID| applications only Serial Ports:
@ Allow other applications CFEE T A
] Use OMS when available Applications:
[ Always 1oad at startup U Inter-application MIDI
QuickTime:
Extras [ Built In
[] Generate Active Sensing Y ari ' :
[ Warids Port
Use the "MIC] Configuration” check boxes to
enable or dizable a port for MICL IF
neceszary , newly added ports will be scanned
for interfaces automatically. To disable a port

temporarily , use the Interface Settings dialog,

|| Ok ll [ Cancel ]

6. The About Quick Setup dialog box will appear. Click [Continue].

* If the dialog will not appear, select "Quick Setup” from the " Configuration” menu.

About Quick Setup

Use Quick Setup to make changes 1o wour FreefID| Configuration docurnent easily,

Certain MIC| devices zan be detected autornatically if the dewice's MICI In and FIGI
Out jacks are both connected to an interface. To use this feature, make sure your
devices and interfaces are turned on and click the "Auto Config...” button below,

Fleaze note that duto Config may not be able to detect every device in wour studio.

Click "Continue..." 1o begin Quick Setup.

Auto Config... | I:::uue. | Ccancel |

7. In the dialog box that appears, select the MIDI devices connected to the various ports of the VariOS.

M anufacturer:
Select "Roland.”

Model:



Select "Other."

Studio L ocation:
Select "VariOS, VariOS Port."

Mew Device: Current Configuration:
Manufacturer: Yarids, Yarios Port
CRotand MIDI Express KT
: Device 1
MDUE]' Device 2
 Other ¥ | | |pavice 3
Studio Location:

-

[ Wari0s, Yari0s Port
Cable: | 3w |

[ »r oAdd = ]

The "&dd" button adds the dewvice
described abowve to the configuration. Be
zure thiz information is correct before

adding the dewvice. [ << Rermove < I || Done “

8. Select "1" under "Cable," and click [ >>Add>> ].

9. Select "2" under "Cable," and click [ >>Add>>].

10. Select "3" under "Cable," and click [ >>Add>> ]. When you've completed this, click [Done].

* If, in addition to the VariOS, you have other M1DI devices connected, you should use the same
procedureto” Add" them aswell.



Mew Device: Current Configuration:

Manufacturer: Yarids, Yarios Port

| Roland - MIDI Express KT
Device 1

Hgdels Device 2

| LRgr z Device 3

studio Location:
| “arils, Yari0S Port

Cable_ 3w [
> Add >

The "&dd" button adds the dewice
described abowve to the configuration. Be

zure thiz information is correct before
adding the dewvice. [ << Rermove < I || Done “

A setting window will appear.
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11. Each device has the following function.

Port name displayed Assign the following port name  Function



|Device 1 ]Roland VariOSMIDI Port for the VariOS sound generating section
Roland VariOS External MIDI |Port for the VariOS rear panel MIDI connector
Roland VariOS Sync Macintosh internal sync port

|Device 2

|Device 3

Double-click "Device" for "VariOS." The "Free MIDI Device Specification” window shown below will appear. Make the
following settings.

Name: /Assign aname as listed above.
DeviceD: Enter "17."

Transmit Channels: |Check all of them (1-16).
Receive Channels: |Check all of them (1-16).

———————————— FreelID| Device SpecificationCQCD—mDDm—m—m——e—
Glame: Raland Yarios MID| )Jew’n::e 1D |
Manufacturer: Model: (1-22)
| Roland w | | Other -

Transmit Channels: e
12345678 910111213141516

i

12. From the File menu, select [Save], and save your settings

This completes the driver settings.



Mac OS 9: Caution when switching the VariOS between VariOS-8, VariOS
303, and VariPhrase modes

[Important] If you turn the power of the VariOS off, then on again, you must also close (and re-open) all OM S
applications.

If even one OM S application isrunning (such as V-Producer, VariOS-8/VariOS 303 Controller, or OMS Setup), you will
be unable to use the VariOS driver no matter how many times you have closed and restarted a given application.

Be aware that if you turn the power of the VariOS on/off while an application is running, the VariOS's MIDI port may still
be visible from the application, but it will actually be unusable.



Using VariOS-8/303 with your sequencer

* [Important] When using VariOS-8/303 with a sequencer such as SONAR or Logic, you must start up your system
in thefollowing order:

(1) Power up theVariOS

(2) Start up VariOS-8/303 Controller

(3) Start up your sequencer (e.g., Logic)
If you power up the VariOS after starting up your sequencer (e.g., Logic), the VariOSUSB MIDI driver may not be
recognized by your sequencer.

VariOS-8/303 Controller settings

If you want to use VariOS-8/303 Controller simultaneously with a sequencer such as SONAR or Logic, set the VariOS-
8/303 Controller setting MIDI through OUT to “None.”

* [Important] If you fail to make this setting, VariOS-8/303 will sound notesin duplicate when you play the
keyboard.

1. From the menu, select [ Setup]-[Setup MIDI Devices).

Set the [ Through] parameter [Output] to “None.”

Setup MIDI Devices

_Marids
Input: Output:
Roland Yarils MIDI :] [Hnland Warils MiDl :]
— Through
Input: Output;
(Pori, T, coblemput 1 (2 )<ore , =
yi N —
/| 4

[ //[MIDI Device Setup..
I

it with another sequencer

: e
Select the port to which your
MIDI keyboard is connected [_Cancel J |___OK “

Select None if you are using ]




If you are using VariOS-8/303 Controller by itself, set the [ Through] parameter [Output] to “Roland VariOS
MIDI.”

Setup MIDI Devices
_Marilds
Input: Output:
Roland Yarils MIDI :] [Hnland Warils MiDl :]
— Through
Input:
[F'u:urt”,u:al:uleinput 1 :]
Fil
[ fffj“llrlDl Device Setup 4 If you arert using only VariOS-8/303,
/ select "Roland VariOS MIDI"
| M
Select the port to which your
MIDI keyboard is connected Cancel | || 0K ll
i
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